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Micro Focus Visual COBOL 2.3 Update 2 for
ISVs Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:

• Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using Microsoft's Visual Studio in one of the following versions 2012, 2013 or
2015. Visual COBOL supports the development and deployment of both managed .NET and native
COBOL applications.

• Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

• Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Visual COBOL.
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What's New
This release provides enhancements in the following areas:

• Integration with Visual Studio
• Integration with Eclipse
• Building applications in Visual Studio
• COBOL language enhancements
• Classic Data File Tools
• Compiler directives
• Debugging applications
• Dialog System GUI
• Editor writing assistance in Eclipse
• File handling
• Library routines
• Tutorials

Integration with the Visual Studio IDE

Back to Top

This release provides the following enhancements in the integration of Micro Focus COBOL with the Visual
Studio IDE:

• A new menu command SQL Option for DB2 on the Tools menu enables you to access all the SQL
Option for DB2 utilities.

• It is now possible to specify options for compiling native resource files (.rc) by accessing the file's
properties from within the IDE.

Editor improvements:

• Colorization of the code in the ToolTips for collapsed regions in the COBOL editor has been added.
• The Time and Date Warp options are now available on the Run-Time Configuration tab when editing

an application configuration file for native COBOL projects.
• Go To Next Method and Go To Previous Method editor context menu commands are now available

for native Object-Oriented and for managed COBOL code.
• Improvements have been made to editing performance.

Integration with the Eclipse IDE

Back to Top

Enhancements are available in the following areas:

• Using the search facility, Search > Micro Focus, you can now limit the search to the copybooks used
by the current program rather than all copybooks in the project or the entire workspace.

• The editor provides a new context menu command, Extract COBOL code to copybook, that enables
you to move a selected segment of the code to a new copybook file in your project. The segment of
code moved to a copybook is replaced with a COPY statement in the original program.

• Support for Eclipse 4.5 - after installing Visual COBOL, you can add it as a plugin into a separate
instance of Eclipse 4.5. See your product's Installation notes.

Building applications in Visual Studio

Back to Top
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It is now possible to use the 64-bit version of MSBuild to build COBOL projects.

COBOL language enhancements

Back to Top

Numeric, edited and external floating point items can now specify USAGE NATIONAL when the
NATIONAL"2" Compiler directive is in effect. Signed numeric items must be specified with the SIGN IS
SEPARATE clause.

Classic Data File Tools

Back to Top

A new command line utility is available which enables you to initiate the following actions: open data files,
create or open record layout files, create or open segment layout files, and open IMS databases using a
DBD or PSB file. Note that although you can initiate these actions from the command line, you must
complete them from within the IDE.

Compiler directives

Back to Top

The following Compiler directives are new in this release:

• COMMAND-LINE-LINKAGE - enables you to call a program and pass the command line to the main
program as a parameter to be accessed via the Linkage Section. This offers equivalent functionality to
the command_line_linkage tunable, which has now been deprecated.

• EBC-COL-SEQ - controls the behavior of an EBCDIC collating sequence, specified in a
NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long-standing fixed
(platform-independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

• NATIONAL - enables you to specify numeric, edited and external floating point items as USAGE
NATIONAL.

Debugging applications in Visual Studio

Back to Top

• You can configure the debug tooltip for subscripted OCCURS items to either display the elements of
arrays or to display the value of the current expression. To do this, right-click in the editor, click COBOL
Debug Tooltip Style and either enable or disable Show COBOL OCCURS or reference modification
value.

Dialog System GUI

Back to Top

Installing the version of the Compatibility AddPack for Visual COBOL provided with this release adds a new
menu item, Micro Focus Dialog System, to the Tools menu of Visual Studio for starting the Dialog
System GUI from within the IDE.

Editor writing assistance in Eclipse

Back to Top

This release provides the following enhancements in the editor in Eclipse:

• Colorization of conditional compilation regions - by default, inactive code is now colored the same as
Compiler directive elements. Inactive code is defined as code within conditional blocks that do not
evaluate with the applied Compiler settings.
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• $REGION statement - support is provided for the $REGION Compiler-control statement. You can use
$REGION - $END-REGION to surround blocks of code that you want to fold or expand in the editor.

• AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version. This
feature is enabled by default and can be configured from a new preference page in Window >
Preferences > Micro Focus > COBOL > Editor > AutoCorrect.

File handling

Back to Top

MFJSORT ICETOOL now supports the USING parameter in the SELECT operator.

Library routines

Back to Top

The following library routine contains new functionality:

• CBL_GET_PROGRAM_INFO - a new function (function 10) has been added for native COBOL which
returns the path and program name, or the program name only of a particular program.

Tutorials

Back to Top

The product help includes the following new tutorial:

• Tutorial: SQL - Deploying an Enterprise JavaBean Containing JVM COBOL to a JBoss Application
Server - an Eclipse-based tutorial that walks you through the process of deploying an EJB that contains
JVM COBOL code.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Enterprise Server
• Compiler
• Eclipse IDE
• MF Directory Server
• Monitoring and Management
• Run-Time System

Compiler

Back to the list

• The ILPINVOKE directive is now allowed only in an initial $SET. This is in line with similar directives like
ILREF and ILTARGET. Previously, the ILPINVOKE directive was allowed in other positions in the source
code, but could later result in 'Insufficient memory' errors.

2860347 (1104422)

• Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)
• There is no longer a problem opening an RM/COBOL indexed file when the program has a RECORD

CONTAINS n CHARACTERS clause and there are record descriptions with lengths less than n. This
situation previously caused a 39 error on the OPEN (other than OPEN OUTPUT) because there was a
mismatch in the minimum record length.

Eclipse IDE

Back to the list

• This update modifies any existing connections defined in an Eclipse workspace. If the connections had
any non-default values, those values could revert to their original default setting. After installing this
release, before you use any remote connections for the first time, you need to check the settings and
amend them as necessary.

2852872 (1103699)

Enterprise Server

Back to the list

• Previously, it was possible to install groups that should not have been installed. If a group name, as
defined in the Startup List, did not exist in the list of Groups then the next Group in the alphabetical
order would be loaded instead. Now, if a Group is not defined in the list of Groups, a warning that the
Group could not be loaded is issued.

2869848 (619107)
• On UNIX, if the "File Path" setting was not specified in the configuration of an Enterprise Server, the

environment variable TXFILEP was defaulting to $COBDIR/etc/cas. This has been changed and
TXFILEP is not populated when the "File Path" is not specified.
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(618668)

MF Directory Server

Back to the list

• The "-n" option for the mfds command now supports hostnames as the network addresses in addition to
IPv4 addresses.

2816871 (1099564)

Monitoring and Management

Back to the list

• Messages that are written to the console log by applications that perform "display upon console" now
contain a standard message ID (CASMG0001I).

2854207 (1103659)

Run-Time System

Back to the list

• The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

2838118 (1101539)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Debugging

• When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.

• Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:

1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
  <DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>

3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.

4. Start Eclipse from the same command or shell prompt.
• Remote debugging does not work for programs running on AIX or HP machines, if you are trying to

debug using Visual COBOL installed on a Linux machine.

Database Access

• If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual COBOL or HCO for
DB2 LUW in Enterprise Developer and the DB2 software is not installed on the client machine where
you are using the Eclipse IDE, you receive background parsing errors in your application. To resolve the
issue, you can do either one of the following:

• Disable background parsing Window > Preferences > Micro Focus > COBOL > Editor and
disabling the checkbox for Background parsing.

• Install the IBM DB2 client-side software on the machine on which you are running Eclipse. Go to the
IBM Support Home and locate the page entitled "IBM Download Fix Packs for IBM Data Server
Client Packages" .

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.
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IDE

• When you add a COPY statement in a COBOL program and then show it in Expanded Copybook View,
the line for the copybook statement is read-only. If you then perform an Undo in the COBOL program,
the COPY statement is removed while the contents of the copybook is still shown in the program.

• Replace All does not work inside the Expanded Copybook View
• For copybooks with file extensions that are not traditionally associated with COBOL you must first add

the file extension to the list of known copybooks extensions in Tools > Options > Text Editor > File
Extensions before you can show them in Expanded Copybook View.

Linking

• Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Viewing the Product Help

• A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with searching and indexing the
help in the Eclipse help viewer if you are running Eclipse on a machine that has this version of JRE
installed.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Character Animator
• Code Analysis
• Codeset Support
• Common Communications Interface
• Compiler
• Data Tools
• Debugging
• Dialog System
• Documentation
• Editor Writing Assistance
• Enterprise Server
• File Handling
• H2cpy
• IDE
• Licensing
• Micro Focus Directory Server
• MVS REXX Emulation
• OpenESQL
• Run-Time System
• Setup
• SQL: COBSQL
• SQL: DB2
• SQL: OpenESQL
• SQL Option for DB2
• XML Syntax Support

Character Animator

Back to the list

• The source file is now found when it is located in the same directory as the .idy file.

2852782 (1103425)

Code Analysis

Back to the list

• The GO TO statements targeting non-exit paragraphs query no longer returns points inside EXEC
statements.

• The performance has been improved.
• The criterion for dead statements within a program has been modified to exclude child elements of

statements.
• Level 78 constant names used in picture definitions are now replaced with the actual values.
• An issue with de-referencing NULL pointers during program generation has been fixed.
• An issue with de-referencing a NULL pointer has been fixed.
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Codeset Support

Back to the list

• A number of DBCS translation tables for CODESET have been added to the deployment product to fix
the 'COBRT255 CODESET cannot open double byte conversion table' error.

2858171 (1104157)
• The following changes have been made to CODESET tables: • The Japanese Katakana Extended

codeset (country code 81) now corresponds to EBCDIC code page 290 when converting between
ASCII and EBCDIC, which means lower case letters (which start at x61, and not x81) can now be
converted. • Unused entries for the following codesets have been filled in order to allow round tripping
(ASCII>EBCDIC>ASCII conversions) of SBCS values: • Japanese Latin Extended, country code 939,
which corresponds to EBCDIC code page 1027. • Korean, country code 82, which corresponds to
EBCDIC code page 833. • Simplified Chinese, country code 86, which corresponds to EBCDIC code
page 836. • Traditional Chinese, country code 886, which corresponds to EBCDIC code page 37.

Common Communications Interface

Back to the list

• The formatting of the context help pages for the Enterprise Server Administration HTML GUI has been
improved.

Compiler

Back to the list

• When a program uses SQL, the debugger could highlight the wrong line when entering that program.
This has been fixed.

2869190 (1105765)
• On 32-bit Intel platforms you could receive an error "001-F Internal error 38" when generating for debug.

2856865 (1104040)
• A COBRT114 error produced at generate time has been fixed.

2853877 (1103611)
• An error in the "ACCEPT binary-floating-point-item" syntax, which occurred on Intel x86 platforms in 32-

bit generated code, has been fixed.
• On UNIX or Linux, Intel x86, 32-bit platforms, callable shared objects no longer state a spurious line

number when reporting RTS 163 run time errors.

• If more than one report shared the same FD, for example: REPORTS ARE REPORT-1 REPORT-2. then
under HOSTRW, the record length was wrong. This has been corrected.

2865849 (1105553)
• Programs using B-AND, B-OR, or B-XOR now compile with the ARITHMETIC"ENTCOBOL" Compiler

directive in effect.

2864991 (1105087)
• A DISPLAY statement containing a very large number of operands now compiles as expected.

2864361 (1105017)
• An inline method invoke with a variable-length group item now produces correct object code.

2864131 (1105018)
• Report Writer now generates the correct record length. Previously, if the BLOCK CONTAINS clause

came after the RECORD CONTAINS clause in the File Descriptor, the BLOCK would corrupt the value
from the RECORD clause, causing the record to have the wrong length when written to the file.

2863045 (1105008)
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• The use of 'AS' as a data-name for programs using an SQL ECM now works as expected.

2863002 (1104821)
• If an INVOKE statement specifies more parameters than the method actually has, an appropriate error

message is produced. Previously, an 'internal error' error message was produced.

2860899 (1104519)
• An INITIALIZE statement performed on a subscripted table containing fields that are object references

or procedure pointers now executes as expected.

2860416 (1104588)
• Messages produced by the FLAGSTD directive now have the correct line and column info reported in

the IDE.

2859026 (1104318)
• A COBOL program compiled with the PROFILE Compiler directive now shows information on the

number of times the program has been called, as well as loaded.

2858944 (1104278)
• When REPLACE is active, a literal containing '''' now compiles as expected.

2858804 (1104264)
• A compilation where a user pre-processor is specified below CP in the pre-processor stack, and this

pre-processor passes COPY statements through unopened, now works as expected.

2858013 (1105427)
• Compilation of a STRING statement, with an operand that reference modifies the result returned by a

user function, now works as expected.

2857266 (1104189)
• A new directive, EBC-COL-SEQ, now controls the behavior of an EBCDIC collating sequence, specified

in a NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long standing
fixed (platform independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

2856776 (1104074)
• SCREEN SECTIONs with very large amounts of fields, which worked in Net Express, now work in

Visual COBOL.

2854533 (1103648)
• Copybook dependency information is now shown correctly in Eclipse for programs compiled with a

preprocessor such as CP.

2854371 (1103662)
• Compiler warning message "COBCH972 Linkage item (or subordinate item) is referenced but has no

addressability" is no longer produced inappropriately.

2854113 (1103542)
• The use of the HOSTRW and CURRENT-DATE directives no longer causes an excessive number of

lines in a report produced from the Report Writer.

2853789 (1105472)
• Subscripts specified via intrinsic function LENGTH-AN no longer receive spurious boundary violation

error messages.

2851928 (1103254)
• Preprocessor created error messages containing SJIS characters are now displayed correctly, as

expected.

2646229 (1089272)
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• A USE FOR DEBUGGING statement that references a table item and is triggered by a condition where
the table item is referenced but not evaluated (due to short-circuit evaluation) now executes as
expected.

2433731 (1073167)

• There is a new option, CP, in EXECPERIOD. It controls the processing of periods that follow EXEC
statements. In most scenarios, the default option, EXECPERIOD(SMART), enables you to compile by
applying a flexible behavior based on the program's context.

2867788 (1105608)

• A CALL statement inside a method could sometimes lead to bad code generation, leading to verification
errors on program load. This is now fixed.

2856883 (1103973)

• If a program contained 'PERFORM of section-name THRU paragraph-name', where the section-name is
known to terminate, the compiler erroneously assumed that the PERFORM THRU terminates (which is
not necessarily the case when paragraph-name is within section-name). This meant that no code was
generated for any statements following that PERFORM statement. This is now fixed.

2871380 (1106107)
• When ILSMARTLINKAGE was specified for a program compiled with the directive ODOSLIDE (which is

set automatically when a mainframe dialect is used), and when the program contained a linkage section
record with multiple OCCURS DEPENDING ON items, then illegal code was being produced with
multiple error messages. This is now fixed.

2870166 (1105899)
• Index names (that is, names defined using INDEXED BY) in the Linkage Section were being allocated

in local storage. This is correct for linkage records in methods, but for procedural programs, they need
to be allocated in working-storage for compatibility with previous behavior. This is now the case.

2870162 (1105922)
• If the OUTDD or INDD directives were in effect, but the CHARSET directive was set to ASCII, then use

of a DISPLAY statement could result in a warning about a 'Reference to undeclared extern assembly'.
This has been fixed. (Note - this situation could arise by setting DIALECT to a mainframe variant such
as ENTCOBOL (which in turn sets OUTDD/INDD), and then setting CHARSET"ASCII".)

2869937 (1105859)
• Level 66 items declared as instance or static data in a class are now accessible from methods.

Previously, attempting such an access produced a compile time error.

2869374 (1105791)
• The ILMAIN directive being set no longer results in incorrect code being generated for the EXIT

PROGRAM statement.

2868383 (1105651)
• If two overloads exist for a method with identical parameters except that one has an additional optional

parameter, then an invocation of the method specifying only the fixed parameters will now choose the
overload without optional parameters. Previously the method with optional parameters was chosen.

2867722 (1105552)
• When compiling for .NET, a sequence of two or more IF NUMERIC tests joined together by the OR

operator no longer causes the Compiler to crash with an error 114.

2866846 (1105400)
• In previous versions of the product, a comparison between an arithmetic expression and a single-digit

literal or data item could produce invalid code in the case where CHARSET"EBCDIC",
HOSTNUMCOMPARE and ILVERIFY were all set. This is now fixed.

2866229 (1105284)
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• Whilst debugging, it is now possible to examine the value of an INDEXED BY item declared inside the
LINKAGE SECTION of a program.

2864353 (1105075)
• The CURSOR IS syntax in the SPECIAL-NAMES paragraph is now working correctly for managed

COBOL code.

2863432 (1104897)
• The use of an EVALUATE statement in one of the WHEN branches of an outer EVALUATE statement no

longer has the effect of switching off the HOSTNUMCOMPARE directive.

2863206 (1104921)
• A TABLE OF expression that includes a subscripted item in its list of operands no longer generates bad

code; previously, this was leading to an invalid program.

2860957 (1104571)
• A COMP-X operand used as a second (or subsequent) operand to a full-screen DISPLAY statement no

longer causes generation of bad code. A move of low-value (or other non-numeric alphanumeric literal)
to a PIC 9(4) display data item now follows RM rules when the ACU dialect is in effect.

2860907 (1104515)
• With ILSMARTLINKAGE, the data access get method for data with multiple subscripts was being

generated incorrectly. This could mean that the value passed for subscripts other than the first was
being ignored. This is no longer the case.

2859095 (1104263)
• When a referenced assembly was loaded, but one or more of its dependent assemblies could not be

found by the Compiler, unreported errors could occur. In particular, this could have the effect that
operator overloads (such as the equality operator for items of type string) were not found. In the case of
string comparisons, this could then result in two strings with the same contents (but different object
references) comparing unequal. Such behavior is now fixed.

2857192 (1104066)
• An issue where Content Assist/IntelliSense did not offer all available extension methods has been

resolved.
• The LENGTH OF expression is no longer allowed on an object expression; an error (COBCH1869) is

produced if attempted. For objects of type string, collection types, or single dimensional managed
arrays, the SIZE OF expression can be used to determine the current size (i.e. the length of string or of
the managed array, or the number of elements in the collection).

Data Tools

Back to the list

• DFCONV now correctly supports a command line length of 1024 characters, as documented.

2868190 (1105640)

• The classic Data File Tools utility now shows the correct field sizes for PL/I array elements.

2858068 (1104147)
• The DFCONV utility now converts correctly between IEEE and 370 floating points.

2857502 (1104054)

Debugging

Back to the list

• In Eclipse, program breakpoints in a program with DECLARATIVES now stop correctly when the
program is entered.

2868653 (1105740)
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• When repeating the debugging of remote 64-bit applications, Eclipse would occasionally hang.

2846587 (1102616)
• When the COBANIMSRV environment variable was used under Windows for cross-session debugging

under Eclipse, the working-storage data items might have displayed 'RT114 error' instead. These items
should now display correctly.

• Examining an object reference with a null value in Visual Studio no longer causes a Run-Time System
error 200 when the application completes.

2863181 (1104826)
• Examining the value of a large OCCURS depending on item no longer crashes Visual Studio.

2855996 (1104988)
• When debugging Object COBOL programs, methods can now be stepped into if the Visual Studio Autos

window is enabled.

• When debugging a program or core file, stack unwind through a signal trampoline could fail on AIX 7.1.

Dialog System

Back to the list

• Installing the Compatibility Addpack now adds a link for the Dialog System painter to the Tools menu in
Visual Studio.

2779520 (1094515)
• The Dialog System configuration information can now be updated using the painter.

Documentation

Back to the list

• The documentation of the format of CCI.INI has been corrected.

2867660 (1105532)
• The product help now clarifies that navigation bar in Visual Studio displays the lists of the objects and

procedures used in the current program as well as the Procedure Division, any sections, paragraphs,
and group level data definitions and enables you to position the cursor on any of them.

2858290 (1104219)
• The topic "Making the Most Out of The COBOL Editor" in the product help for Visual Studio now

provides a link to the information about limitations with single file support.

2858263 (1104217)
• Information on setting the mfdepinst security credentials in the .mfdeploy file in the deployment parent

directory has been added to the documentation.

2854625 (1103607)
• The product help now includes information about the ExcilRespException and InvalidDataException

classes and corresponding serialized form information.

2851195 (1103171)
• The 'This Page' help link in Enterprise Server on UNIX now opens the Help.

2818256 (1099110)
• Changing the project's connection type can result in the project losing the connection to its version

control system. You can re-establish the connection with your version control system in the Share
Project dialog.

2792882 (1101965)

• Step five in the installing on UNIX was missing the period that goes before "/opt". It now reads:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv
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2855600 (1103829)

• The product help has been updated to remove the requirement to install the gcc libraries. These
libraries are not required to install and configure the product and then for the basic functionality. gcc is
only required if you need to use C and COBOL together and gcc will be installed together with the
required development tools.

2863618 (1104878)
• User exits MFDASIMP and MFDASEXP are now documented.

2858575 (1104507)
• Updated the information on the action of the MFJESPWR user exit program contained in the

documentation.

2856725 (1103944)
• The DATAFIELD built-in function has been removed from the documentation.

2852986 (1103391)
• Details have been added to the topics "To enable Windows Event Logging" and "To enable Performance

Counters" to state that the user must be able to write to the appropriate registry, and have appropriate
privileges, to complete these tasks.

2840002 (617369)
• ECI programs that use mfccl.jar raise an error exception, EXCIException, if exciResp1 and exciResp2

are not both equal to zero. To ensure your ECI program captures all errors, you must catch this
exception in your code. Please add the following code snippet, which enables your program to compile
and execute properly: try { … } catch(ExciException e) { String rcMsg = e.getRcMsg(); } If an error
occurs, rcMsg captures the appropriate error message.

2830787 (1100664)
• The documentation for the “MF Directory Server Security” page has been clarified, to show that the

Security Facility Configuration parameters are available on this screen only when MFDS is configured to
use an ESF (i.e. setup to use a Security Manager other than "MFDS Internal Security"), otherwise no
ESF security configuration options (including the caching options) will be seen on this MFDS Security
tab screen. These parameters are: Allow unknown resources Allow unknown users Cache limit Cache
TTL Create audit events Verify against all Security Managers

• The product Help now includes some additional details on creating advanced filters for using regular
expressions with the Compare and Synchronization Monitor.

2645110 (1089268)

Editor Writing Assistance

Back to the list

• IntelliSense (Visual Studio) and Content Assist (Eclipse) would sometimes not offer reserved word
types where they were valid.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) offered unqualified managed members where
they could not be used without qualification.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) sometimes offered invalid pointer items.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) incorrectly offerred level 88 itens or require

them to be qualified.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer items in the PERFORM USING

statement.
• An issue where members with reserved word names were not colorized correctly has been fixed.

IntelliSense (Visual Studio) and Content Assist (Eclipse) suggestions are now offered in member
headers for members with names that are reserved words.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not show options after items which were
subscripted or reference modified.
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• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not correctly offer typedefs in LENGTH OF
phrases.

• Items from external programs were incorrectly offered in IntelliSense (Visual Studio) and Content Assist
(Eclipse).

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer variables with the same name as
classes, methods or properties in the same file.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer suggestions after variables with
the same name as classes, methods or properties in the same file.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) omitted options after the SET SIZE [OF]
statement.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer items within indexers on natively
typed arrays.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) did not offer or recognise PIC 1 items within
conditional expressions.

• IntelliSense (Visual Studio) showed the wrong members after a cast to SUPER.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) sometimes did not list any members after

names of unqualified types.
• The Content Assist (Eclipse) and IntelliSense (Visual Studio) lists would not include any options if there

where unknown parameter types in the code.
• Some IntelliSense (Visual Studio) and Content Assist (Eclipse) proposals for items from external

programs did not have any descriptions.
• If there were multiple items with the same name declared in external programsm they were not offered

correctly by IntelliSense.
• IntelliSense now supports constructing instances of the current or parent type using either NEW SELF

or NEW SUPER.
• IntelliSense in Visual Studio would sometimes show the wrong members for unqualified type names

within partial classes.
• Content Assist (Eclipse) and IntelliSense (Visual Studio) now offer to qualify file record items by their FD

items.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) would sometimes list the wrong members after

an unqualified type name.

Enterprise Server

Back to the list

• The CASGLM.LCK and ESCLRMLs.cfg files were not generated if the system catalog was in a spacey
path.

• The security when displaying any of the Enterprise Server configuration pages in the Enterprise Server
Administration HTML GUI has been increased.

2846702 (1102642)
• The "Renew" command available from the left hand side navigation pane in the Enterprise Server

Administration HTML GUI did not work when SSL was enabled.

• A potential memory corruption when a SEP executing an EXEC CICS DELAY is killed has been fixed.
This situation only occurred when TRANCLASS was enabled.

2865931 (1105228)
• An initial 3270 terminal connection could hang if there was an attempt to send an error message to the

terminal not yet connected and an XA error occurred at the same time.

2865927 (1105226)
• IN-only messages are now supported for CICS Web Services.

2864329 (1104991)
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• An issue causing an RTS 114 error in mfjclsub when a CICS program executed a 'display' call in an
SSTM-enabled region has been fixed.

2858651 (1104770)
• It is now possible to programmatically change the name of a Web service displayed in the HSF records

by calling the following entry point: call 'ES_trace_application_data' using by reference ws-trace-block .
Where ws-trace-block is defined as follows: 01 ws-trace-block. 03 ws-trace-version pic x comp-x. 03 ws-
trace-data. 05 ws-trace-type pic x comp-x. 05 ws-trace-text pic x(255). - ws-trace-version and ws-trace-
type must have a value of 1. - ws-trace-text is restricted to 255 bytes in length, must be terminated by
low-values (x'00) and must not have any spaces embedded in it.

2856234 (1103860)
• When using cassout from the API and not cancelling it between calls, it was possible to overwrite the file

output from a previous invocation if the '-d' option (output to file) was not specified. The product now
initializes the required environment variables on each invocation to ensure this problem does not occur.

2852058 (1103778)
• Trying to access ESMAC in a secure region no longer results in the application crashing.

2851933 (1103724)
• On a CICS stateful request, after a run-time system failure, a transient SEP could loop, produce an RTS

114 error or an abend CDCD on shutdown during SDP2. This was caused by the ATP not being at the
expected level when running SDP2.

2851618 (1103389)
• The casutl command line utility supports a new option, /n. When used with /n, the utility starts a new

console.log and saves the contents of the current console.log to a new file,
console.nnn_switch_date_time (where nnn is a number).

2851178 (1103265)
• Visual COBOL and COBOL Server with SOA now include castran with the CANCEL support.

2849934 (1103037)
• Credentials are now masked out in the formatted dump.

2848888 (1102908)

• A default password for an external Security Manager connection is no longer used when you specify a
user id but not a password. This is to help avoid locking out the user id. Also, if no password has been
specified, the Enterprise Server Administration HTML GUI no longer displays a dummy value in the
password field on the Security Manager configuration page.

2864790 (1105187)
• Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.

2863222 (1104948)
• Restricting access to the Enterprise Server External Security Facility's Admin API for the MLDAP ESM

Module now works correctly when you use resource definitions in the optional AdminAPI class.

2830660 (1100636)
• With some types of tracing enabled, the MLDAP ESM Module for Enterprise Server security would

sometimes report that a group ACE matched the user's logon group when in fact it did not match. The
trace message now correctly indicates whether the ACE matched or not.

• When using Enterprise Server security with LDAP, on some platforms, a resource access rule with an
empty access control list (ACL) could cause an RTS 114 or other program crash. This has now been
fixed.

File Handling

Back to the list
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• An internal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.

2868664 (1105707)
• When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler

was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.

2864802 (1106106)
• VB files are now created with the correct lrecl, taking into account the extra space for a print character

when creating the file header.

2856899 (1104023)
• FS_CHECK_FILE_EXIST is now being processed correctly when called with an environment variable

that contains a Fileshare server-name. Previously, the request was not being sent to the server.

2851717 (1103253)
• Memory is now correctly being deallocated at end of IMS rollback recovery processing; previously, it

was not.

2840046 (1101795)
• When running non-transactional file handling, a record-locked status will also return the process-id of

the locking process when run on UNIX and using FCD3. This means C$LOCKINFO can also return this
information for Micro Focus files. This behavior does not apply to Fileshare.

2832733 (1101061)
• The rollback recovery process is now working as expected.

2802180 (1097066)

• For corrupted files, where a corrupted offset occurs beyond the end of the file, you now receive a
validation message instead of a Run-Time System error 114.

2860981 (1104576)

• When MFJSORT fails to open SYSOUT, it now gives an error message to the console, and then
abends.

2861239 (1104614)
• The MFJSORT E15 user exit is now giving the correct record length.

2858360 (1104276)
• A COBOL SORT called from JCL no longer causes a COBRT200 error message in managed code.

2857600 (1104073)
• SORT now treats leading spaces in ZD fields as zero, which emulates mainframe behavior.

2855141 (1103700)
• The conversion of PD to ZD is now giving correct SORT results for negative numbers.

2854443 (1103597)

H2cpy

Back to the list

• H2cpy now successfully parses cURL header files.

2858155 (1104162)

HCO for Microsoft SQL Server

Back to the list

Resolved Issues | 21



• The OpenESQL pre-compiler generated code has been modified to perform swap logic for COMP fields
if an SQLCODE of -305 or -811 is also returned, as data can be returned with either of those
SQLCODEs.

2871163 (1106063)
• An issue with OpenESQL handling cursor names that start with "CURSOR" has been fixed.

2866507 (1105337)
• An issue where HCOSS was not locating the correct stored procedure for a bound statement in multi-

step JCL jobs has been fixed.

2861657 (1104733)
• When using DIALECT=MAINFRAME, if a program references a DECLARE GLOBAL TEMPORARY

TABLE before the declaration, the precompiler now produces a warning and not an error message.

2853667 (1103453)

IDE

Back to the list

• In Visual Studio 2015 or later, the Properties window for assembly references might have incorrectly
displayed a value of "false" for the 'Copy Local' property.

2868449 (1105875)
• Visual Studio should not support editing of data items at a group level. This is option is now disabled.

2864986 (1105083)
• When debugging an application running on a remote machine with the expanded copybook debugging

enabled, the Visual Studio debugger now steps on the correct lines. In such cases, if the application
sources are not loaded in Visual Studio, the debugger will not step the copybooks inline. Instead, it will
open the copybooks in a separate tab in the editor.

2864082 (1105134)
• Debug tooltips are now shown correctly in statements that contain multiple data items.

2862422 (1104764)
• When building a COBOL project, outlining would be temporarily turned off for any open source files.

2860767 (1104493)
• The IDE setting "Debug tooltip style for OCCURS items" in Tools > Options > Micro Focus COBOL >

Advanced has been renamed to "Show COBOL occurs or reference modification value" and is now
available under Tools > Options > Debugging->Micro Focus COBOL. While debugging, you can enable
this setting directly from the editor - either choose "COBOL debug tooltip style" from the editor context
menu or from the context menu of the debug tooltips.

2858786 (620858)
• Watchpoints are now hit when debugging Mainframe Subsystem applications.

2857670 (1104106)
• The environment variables specified on the Environment tab in the Application Settings dialog box when

you edit a project's Application.config file are now expanded when the application is executed from
within Visual Studio.

2853990 (619225)
• The editor is now more responsive when editing large source files.

2852087 (1103629)
• It is now possible to switch off the colorization of uncompiled code in the editor - click Tools > Options >

Text Editor > Micro Focus COBOL > Advanced and set "Enable inactive code colorization" to False.
Switching this setting off can help improve the editor performance.

• The debugger is now positioned on the correct source line when debugging 64-bit Oracle Pro*COBOL
programs.
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• It is now possible to specify options for compiling native resources files (.rc) by accessing the files'
properties from within the IDE.

• This release offers various improvements in the performance and stability of outlining support in the
COBOL editor.

• The Call Hierarchy and Quick Browse window now display information about items with non-ASCII
names.

• IntelliSense and colorization did not work in the Visual Studio COBOL editor in sourceformat(free) when
the first word on the line started with a "d", and this was not a debug indicator.

• When querying items, if you expand the tables and groups, they now show the element name rather
than a fully qualified name. This is to improve the readability.

• Visual Studio could crash when attempting to use the "Debug/Attach to Process" feature and when
Visual Studio was started with non-administrator privileges.

• In the Project Details Window, unchecking the Allow Columns Reorder context menu option would crash
the IDE.

• Displaying the context menu for a file in the Project Details Window could sometimes cause the IDE to
crash.

• Copybook dependencies are now shown correctly within Eclipse for 64-bit compilations.

2866406 (1105576)
• You can now customize task tags for the COBOL, JCL, and PL/I editors.

2865386 (1105306)
• A password in no longer required to establish an SSH connection in the Remote System view.

2863953 (1105480)
• Additional options are now correctly saved in the .cobolBuild and .cobolProj files.

2863027 (1104789)
• A PL/I macro invocation used as a statement parameter is no longer reported as an error.

2862571 (1104763)
• PL/I background parse no longer reports an error when a macro replacement string is a DCL statement

that ends with a semicolon.

2862568 (1104767)
• Code coverage report generation now works where a project depends upon a copylib project.

2858045 (1104184)
• The MFA connection sign-on dialog could be displayed at startup, it is now displayed when the

connection is being established.

2857986 (1104150)
• Hyperlink detectors defined in the Eclipse preferences for "Textual Editors" were not enabled for the PL/I

and COBOL editors.

2856932 (1103984)
• The performance of the "Updating Micro Focus model" job, user interface responsiveness and memory

consumption have been improved when folders containing large numbers of files are added to an
Eclipse project.

2856154 (1105184)
• It is now possible to load templates in columns 1-7 in COBOL programs using content assist.

2855703 (1103770)
• Updating the Micro Focus Model could result in high CPU and Disk IO. This has now been fixed.

2854512 (1103605)
• The auth.pl process no longer hangs when the user ID is blank or null.

2851049 (1103233)
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• The generated .cobolBuild ant scripts now contains target names using simple filenames instead of full
file system paths for the FileCompile.filename targets.

2847988 (1102977)
• A problem with the core Eclipse code could cause a full project rebuild to occur when not required. This

has now been fixed.

2816310 (1104735)

Licensing

Back to the list

• The SafeNet installer now uses tar instead of PaX. This is to ensure compatibility across platforms.

2860254 (1104400)

Micro Focus Directory Server

Back to the list

• Fixed an issue where XA open string which included the "=" character would not display correctly in the
Enterprise Server Administration HTML GUI.

2856722 (1103958)
• If a user attempts to login to the MFDS process using a valid ID but an invalid password the message

"ML3073W Unknown user" is no longer logged in the MFDS journal output.

2842321 (1102116)

MVS REXX Emulation

Back to the list

• This release provides a technology preview support for the DSNREXX commands for DB2 LUW.

2842140 (1102170)

OpenESQL

Back to the list

• A problem with SQL(SQLCLRTRANS) that caused a COBOL 173 runtime error on stored procedures
that make COBOL calls to other modules has been fixed.

2871330 (1106084)
• A problem using SQL(CHECK) with statements that contain a FOR :hostVariable prefix has been fixed.

2868823 (1105704)
• In managed code only, a problem with the OpenESQL preprocessor sometimes generating incorrect

code after a stored procedure call resulted in some data being returned incorrectly. This has been fixed.

2868405 (1105663)
• Compiler errors sometimes resulted when the SQLCLR wrapper generator generated duplicate

parameter names. This has been fixed by updating the generator to check for the potential of duplicate
names and choose an alternate extension to insure unique names.

2866086 (1105262)
• The OpenESQL Managed Runtime for ADO.NET now allows non-printing characters in PIC X host

variables.

2865166 (1105140)
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• The OpenESQL pre-compiler incorrectly generated code for programs compiled with
CHARSET(EBCDIC) and SQL(DBMAN=ADO) when SQL statements were greater than 4000
characters.

2864850 (1105064)
• Previously, the SPD Generator did not handle correctly some of the parameters which resulted in

generating an incorrect COBOL code.

2864348 (1104993)
• The OpenESQL component was updated to resolve an issue executing the HCOSS Assess Application

Migration tool when either no Visual Studio product was installed, or just the Visual Studio Integrated
Shell was installed.

2864021 (1104951)
• The SPD generator incorrectly handled quotes around the procedure name, resulting in a compile error

of generated COBOL code. This has been corrected.

2863699 (1104906)
• HCOSS was improperly handling UPDATE statements that uses row constructors based on a subquery.

This has been fixed.

2860329 (1104628)
• Using SQL(DETECTDATE=SERVER) with queries containing single quote characters sometimes

resulted in an error. This has been fixed.

2857619 (1104103)
• The DCLGEN function of OpenESQL Assistant now supports including comments in copybooks for the

Label extended properties on SQL Server columns.

2856215 (1104118)
• The SQL(CHECKSP) Compiler directive has been added to list of directives which you can set from the

project's or a file's properties. Also, receiving an error message that the SPD file was not found no
longer causes compiling to hang.

2853668 (1103454)
• A problem with the ADO.NET run-time system for OpenESQL not implementing the default threading

behavior for THREAD=SHARE has been fixed, enabling single-user applications, such as Windows
Forms or WPF applications, to use background worker threads provided that the application takes steps
to ensure that only one thread executes embedded SQL statements at a time. When using the
THREAD directive, be aware that ADO does not support THREAD=ISOLATE. For multi-user
applications, we recommend using COBOL run units instead.

2850789 (1103122)

Run-Time System

Back to the list

• A statement "MOVE <justified-alphanumeric-item> TO <numeric-item>" no longer produces a
COBRT200 error.

2869985 (1105986)
• If the Audit Manager was under heavy load by many client processes and was then re-cycled, it was

possible that the client processes would not send the correct details when attaching to the new Audit
Manager process, which would cause Audit Manager to crash. This is now fixed.

2863509 (1104863)
• Pasting of DBCS characters that have a 2nd byte of x"E0" is now working correctly.

2861398 (1104580)
• A dynamically bound application DLL that uses Object COBOL no longer hangs intermittently when

loaded concurrently in multiple threads.
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2858271 (1104328)
• An additional sub-function has been added to the CBL_GET_PROGRAM_INFO library routine. The

sub-function, number 10, returns a program's full path, or name only, depending on flag settings.

(618769)
• Detaching from animation that was started using the debug_on_error tunable could cause animation to

re-start again for the initial error - this has now been resolved.

• In managed COBOL code, setting an environment variable to spaces or low-values now unsets that
environment variable.

2864896 (1105147)
• You now receive a correct error message when the CBL_CHECK_FILE_EXIST library call is used with

DD_ environment variable expansion on a directory that already exists.

2864515 (1105023)
• In the .NET COBOL Run-Time system, default NLS messages are now returned for locales that do not

have the messages defined.

2863236 (1104831)

Setup

Back to the list

• The UNIX setup file now supports the SuSE 12 SP1 version of spax.

2866227 (1105283)
• The Install.sh script now performs the correct disk space checks to determine if there is enough space

on SOLARIS SPARC machines prior to installing.

2854557 (1103628)

SQL: Cobsql

Back to the list

• A problem with processing an SQL statement when it was on the same line as a COBOL condition
resulted in a CSQL-F-026 error. This has been fixed.

2864989 (1105085)
• A problem with COBSQL incorrectly handling EXEC SQL INCLUDE statements has been fixed.

2821960 (1099586)
• A problem with COBSQL not recognizing or properly processing a section that comes directly after

comment lines and returning an error has been fixed.

2818934 (1099169)
• A problem with COBSQL not properly invoking cobpre64 when COBSQLTYPE is set to SYBASE has

been fixed.

2794407 (1096173)

SQL: DB2 ECM

Back to the list

• A problem with the HCO import tool incorrectly handling packed decimals greater than 18 digits has
been fixed.It has been updated to now handle packed decimals up to 26 digits.

2866180 (1105278)
• The DB2 pre-compiler sometimes incorrectly restored the RETURN-CODE after a SQL statement was

executed.
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2857403 (1104045)

SQL: OpenESQL

Back to the list

• The INSENSITIVE option is no longer available for the STATICREADONLY directive.

2871907 (1106251)
• A problem with error message handling in the ODBC run time for SAVEPOINT statements has been

fixed.

2870141 (1105889)
• A problem with HCOSS incorrectly renaming parenthesized expressions in select lists has been fixed.

2869320 (1105787)
• SQL(SPTHROWEXCPETION) now throws an exception only for errors that result when SQL Server

terminates the current transaction.

2868965 (1105736)
• SQL(DETECTDATE) would sometimes incorrectly match dates and times in European and USA

formats.

2868282 (1105622)
• A problem with the OpenESQL preprocessor failing to properly check the length of an SQL statement

properly, resulting in a 153 RTS error, has been fixed.

2867772 (1105549)
• A problem with OpenESQL SQL Entry and Exit not showing in trace output has been fixed. The trace

output is now sent to Auxiliary trace during CICS transaction execution.

2867423 (1105490)
• A problem running SQL CLR stored procedures on heavily loaded servers has been fixed.

2865750 (1105229)
• A problem with OpenESQL allocating duplicate server cursor names for positioned updates in stored

procedures has been fixed.

2865750 (1105230)
• A problem with the OpenESQL Assistant generating copybooks with TINYINT columns as PIC S9(2)

COMP-5 rather than PIC S9(4) COMP-5 has been fixed.

2865378 (1105139)
• HCOSS now correctly handles hexadecimal constant strings.

2865026 (1105146)
• A problem with the OpenESQL preprocessor when compiling with the CHARSET(EBCDIC) directive

sometimes generating COBCH0002/COBCH0302 compilation errors for programs that used arrays as
host variables in SQL statements has been fixed.

2864585 (1105039)
• OpenESQL now supports DESCRIBE CURSOR statements.

2863839 (1104939)
• A problem with HCOSS handling the SUBSTRING function when only three parameters are supplied

has been fixed.

2862754 (1105122)
• HCOSS now correctly handles the DB2 TRUNCATE scalar function when the function is called with only

one parameter.

2862064 (1104674)
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• HCOSS could sometimes report a SQL(CHECK) error as a warning instead of an error.

2861897 (1104668)
• The ODBC pre-compiler now swaps array variables using DO UNTIL loops similarly to how it does this

for COBOL. This considerably reduces the number of statements generated for array variables.

2861580 (1104613)
• HCOSS now correctly sets SQLCODE = 100 for a rowset fetch that retrieves fewer rows than the host

array size.

2861570 (1104629)
• HCOSS now handles correctly FETCH FIRST and ORDER BY clauses in queries that use set

operators.

2861567 (1104751)
• A problem with OpenESQL incorrectly handling DB CAST expressions that use FOR BIT DATA has

been fixed.

2861516 (1104689)
• HCOSS no longer trims trailing spaces automatically from input host variables when

SQL(DIALECT=MAINFRAME) is set.

2859565 (1104692)
• Previously, you could incorrectly receive truncation warnings for output parameters of Oracle stored

procedure calls that are character fields narrower than 19 characters.

2859200 (1104598)
• Using MySQL ODBC 5.6 or later with OpenESQL in VC/ED 2.3 or later caused an RTS 114 error. This

has been fixed.

2858980 (1105338)
• Problems with the OpenESQL Assistant that caused the "no columns in table" error have been fixed.

2856643 (1103936)
• A problem with applications compiled with the SQL(INIT=PROT) directive caused Enterprise

Server .NET jobs to hang. This has been fixed.

2856198 (1104002)
• HCOSS now supports DB2 RELEASE SAVEPOINT statements and problems with global temporary

table housekeeping and ROLLBACK TO SAVEPOINT statements have been fixed.

2856008 (1103831)
• The SPTHROWEXCEPTION SQL compiler directive option has been added to improve diagnostics

returned to calling applications from COBOL SQL CLR stored procedures in the case of an implicit SQL
Server rollback on a transaction.

2854780 (1103670)
• A problem with OpenESQL not allowing 'NO' to be used as an SQL identifier has been fixed.

2854592 (1103598)
• A problem with the JDBC runtime incorrectly setting SQLCODE on repeat execution of EXECUTE

IMMEDIATE statements has been fixed.

2854393 (1103713)
• A problem processing the EXEC ADO DATATABLE <name> BIND statement resulted in a COBES0100

error. This has been fixed.

2854004 (1103529)
• Some problems with DB2-style result sets where allocated cursors are reused without being closed and

where cursors must remain open across multiple calls to the same stored procedure have been fixed.

2853859 (1103520)
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• EXCEL table names enclosed in single quotes were incorrectly handled by the DCLGEN function of the
OpenESQL Assistant, resulting in an unhandled exception. This has been fixed.

2853832 (1103555)
• The COBOL Run-Time system now successfully loads the ODBCRW64.DLL file when a native COBOL

application is being called from a C# application.

2853578 (1104167)
• The OpenESQL directives SQLCLRTRANS and SPDISPLAY now work correctly for Enterprise

Server.NET batch jobs.

2853439 (1103430)
• An HCOSS problem transforming SQL statements that contain both XML and CONCAT operators has

been fixed.

2853412 (1103426)
• The OpenESQL ODBC runtime has been updated to ensure that connections are closed after a

DISCONNECT.

2853341 (1103461)
• HCOSS now correctly handles WITH DEFAULT clauses in table definitions that do not specify a default

value.

2852996 (1103431)
• HCOSS now supports DB2 DECLARE GLOBAL TEMPORARY TABLE statements that use AS <query>

and LIKE <tableName>.

2850369 (1103793)
• The SQL(PROCOB) directive option for the OpenESQL preprocessor now supports Pro*COBOL's

syntax for calling database functions when SQL(DBMAN=ADO) is also set. In addition, a problem that
prevented DML from being executed in user-defined functions has been fixed.

2849318 (1102957)
• The SQL(PROCOB) directive option for the OpenESQL preprocessor has been updated to process

Oracle grouped host array syntax.

2849301 (1102956)
• To fix a problem with the DETECTDATE directive not allowing runtime control of datetime data

formatting, the OpenESQL SET <hostvariable> and SET OPTION statements have been enhanced to
allow datetime data formatting behavior equivalent to the OpenESQL DATE, TIME, DATEDELIM,
TIMEDELIM, TSTAMPSEP, and DETECTDATE directives.

• A problem with positioned update when using the latest release of the PostgreSQL ADO.NET provider
has been fixed.

• The namespace used by the JDBC runtime for OpenESQL has changed from
MicroFocus.COBOL.SqlJVM to com.microfocus.openesql.

• The 32-bit Windows DLL names used in OpenESQL JES program-alias mapping have been changed
as follows: SQLTP232 to SQLTP2 SQLUTB32 to SQLUTB.

• Using the CHARSET(EBCDIC) directive with OpenESQL sometimes caused the preprocessor to
generate incorrect code for converting SQLCA fields, resulting in CONNECT failures. This has been
fixed.

• The SET host-variable embedded SQL statement has been added to OpenESQL to enable you to
query the current connection name and database type.

• Cursor prefetch behavior in OpenESQL has been made more consistent with updates to the
PF_RO_CURSOR and PF_UPD_CURSOR primitive compiler directive options for BEHAVIOR, and the
MARS compiler directive option. See your product documentation for complete details.

SQL Option for DB2

Back to the list
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• The SQLN value in SQLDA is no longer modified when a FETCH is performed using invalid SQLVAR
SQLDATA pointers.

2854157 (1103541)

• A Run-Time System error "-84 UNACCEPTABLE SQL statement" could occur when there was a
VARCHAR host variable definition with an extra 49 level FILLER statement.

2867096 (1105432)
• Modified the XDB precompiler to no longer generate COBSQ0413S errors if the program is compiled

with directive XDB(BEHAVIOR=STACKED).

2855151 (1103687)

• The XDBSetup utility supports creating a user XDB.INI in the user's local application space.

2839228 (1101904)

• An issue with scalar functions invoking aggregate functions invoking more scalar functions with
embedded host variables has been fixed.

2869971 (1105862)
• A problem that resulted in XDB Server providing incorrect SORT results when using ROWSET

POSITIONING has been fixed.

2867209 (1105454)
• Implicit casting is now carried out for SUBSTR() arguments in the V10 XDB engine.

2865204 (1105108)
• A problem with uninitialized query common space generating an illegal decimal data error has been

resolved.

2860427 (1104449)
• XDB Server has been updated to correctly return results from XDB SQL when certain statement

combinations are executed.

2856158 (1103932)
• Some SQL queries that return data on the mainframe did not return data in XDB. These queries now

return data in XDB as well.

2853378 (1103442)
• The XDB SQL optimizer has been updated to use a new compound index routine. This corrects a

problem that caused a thread access violation when processing a very large join restriction queue that
had overflowed to disk.

2853078 (1103385)
• A problem with the XDB server corrupting a row after executing a program that uses a FOR UPDATE

cursor has been fixed.

2850725 (1103117)
• Multiple issues that occurred when the reserved word SELECT was used as an identifier have been

resolved.

2849898 (1103024)
• A problem causing the SQL result to be inconsistent when using the SELECT... IN clause has been

fixed.

2849892 (1103103)
• A problem when creating a unique index, that resulted in an "x020: Syntax error. Last symbol read was

'INCLUDE'" error message, has been fixed.

2847745 (1102766)
• SQL Option now supports PARTITION BY SIZE syntax for DB2 version 9.

2845161 (1102494)
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• XDB no longer throws an X405 error message when it encounters a NOT operator that is part of a
compound predicate.

2640689 (1088784)

XML Syntax Support

Back to the list

• In some scenarios, XMLPARSE returned an RTS 114 error while parsing certain XML documents.

2851143 (1103185)
• When reading an empty XML document, the returned file status is now -7.

2851074 (1103216)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2865238 (1105114)
• 2871930 (1106185)
• 2866567 (1105346)
• 2865516 (1105153)
• 2865065 (1105097)
• 2857117 (1104003)
• 2872217 (1106234)
• 2864576 (1105124)
• 2855891 (1103807)
• 2864100 (1104959)
• 2867120 (1105479)
• 2865687 (1105211)
• 2864343 (1105019)
• 2858008 (1104163)
• 2858007 (1104161)
• 2835721 (1101500)
• 2835605 (1101499)
• 2858091 (1104136)
• 2865419 (1105238)
• 2864875 (1105074)
• 2861263 (1104753)
• 2859986 (1104407)
• 2855942 (1103906)
• 2679133 (1093595)
• 2852255 (1104353)
• 2856233 (1103855)
• 2867934 (1105578)
• 2867215 (1105455)
• 2866174 (1105419)
• 2858808 (1104227)
• 2855088 (1103672)
• 2853477 (1103462)
• 2852874 (1103543)
• 2839669 (1101704)
• 2836259 (1101305)
• 2808029 (1098883)
• 2790796 (1095836)
• 2854829 (1103653)
• 2854739 (1103627)
• 2866458 (1105348)
• 2865807 (1105205)
• 2864327 (1104989)
• 2862599 (1104785)
• 2848016 (1102774)
• 2843761 (1102734)
• 2841092 (1101887)

• 2865193 (1105135)
• 2864092 (1106070)
• 2859740 (1104343)
• 2859539 (1104350)
• 2856245 (1103972)
• 2855704 (1104105)
• 2855440 (1103871)
• 2853585 (1103448)
• 2852872 (1103696)
• 2852872 (1103930)
• 2852872 (1103931)
• 2851306 (1103352)
• 2840161 (1101839)
• 2799183 (1096680)
• 2863024 (1104786)
• 2853074 (1103489)
• 2848947 (1103100)
• 2816310 (1104173)
• 2859923 (1104371)
• 2650949 (1090062)
• 2854470 (1103640)
• 2857870 (1104107)
• 2809343 (1099937)
• 2858035 (1104156)
• 2856499 (1104222)
• 2857318 (1104188)
• 2858539 (1104204)
• 2856795 (1103963)
• 2840704 (1103249)
• 2863482 (1104862)
• 2861561 (1104610)
• 2860719 (1104512)
• 2858941 (1104253)
• 2858723 (1104229)
• 2856941 (1103977)
• 2856206 (1103880)
• 2861649 (1104679)
• 2853710 (1103578)
• 2867842 (1105600)
• 2865028 (1105119)
• 2860212 (1104480)
• 2854400 (1103587)
• 2852486 (1103340)
• 2842820 (1103533)
• 2855179 (1103705)
• 2855179 (1103707)

• 2819868 (1099861)
• 2865350 (1105129)
• 2864599 (1105025)
• 2853376 (1103486)
• 2855231 (1103701)
• 2870740 (1106000)
• 2858161 (1104152)
• 2864758 (1105772)
• 2856295 (1103875)
• 2839181 (1101830)
• 2864619 (1105054)
• 2861296 (1104593)
• 2860006 (1104387)
• 2854108 (1104290)
• 2848917 (1103264)
• 2838891 (1101791)
• 2648290 (1089566)
• 2864197 (1105004)
• 2852655 (1103333)
• 2869703 (1105832)
• 2869126 (1105760)
• 2852996 (1103913)
• 2859001 (1104312)
• 2869594 (1105948)
• 2867462 (1105499)
• 2866779 (1105567)
• 2865650 (1105214)
• 2865630 (1105243)
• 2865078 (1105100)
• 2865051 (1105317)
• 2865003 (1105132)
• 2863175 (1104845)
• 2860863 (1104746)
• 2860785 (1104563)
• 2859507 (1104314)
• 2859155 (1104316)
• 2859044 (1104282)
• 2857023 (1104176)
• 2857021 (1103995)
• 2856592 (1104053)
• 2852281 (1103298)
• 2818259 (1099422)
• 2865602 (1105177)
• 2863239 (1105044)
• 2861423 (1104585)
• 2858787 (1104233)
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• 2869763 (1105896) • 2851107 (1103173)
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Installation

Before Installing

Downloading the Product
You can download Visual COBOL from the Product Updates section of the Micro Focus SupportLine Web
site.

System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The maximum disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

1.2Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• You can produce both 32-bit or 64-bit applications with Visual COBOL installed on a 64-bit
operating system.

• Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.
• The Enterprise Server feature is not supported on Windows XP.

Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Note:

• Besides the software listed below, the setup file also installs the 32-bit Java 8 Update 51.
• This product includes OpenSSL version 1.0.1p.
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Visual Studio IDE

This product requires Microsoft's Visual Studio.

You need one of the advanced versions of Visual Studio listed below or the Visual Studio Integrated Shell
(only supported by Visual COBOL for Visual Studio 2012 or 2013):

Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)

Microsoft's Visual Studio Express Edition is not supported.

If there is no Visual Studio installed on your machine, the setup file for Visual COBOL for Visual Studio
2012 or 2013 will install the Visual Studio Integrated Shell. Alternatively, you can download the Visual
Studio Integrated Shell from the Microsoft Download Center and install it before you install Visual COBOL.
If you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or the
Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for more details.

Important:

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Visual COBOL for Visual Studio 2013.

• Visual COBOL for Visual Studio 2015 does not support Visual Studio 2015 Shell as the Shell has a
number of restrictions to COBOL development. The Visual Studio 2015 Shell is not included in the
setup for Visual COBOL for Visual Studio 2015 and before you start the installation, ensure that
there is an advanced edition of Visual Studio 2015 installed on your machine.

• On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the 
Microsoft Download Center.

• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.

• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.
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• Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

The following software is also required:

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
• Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
• Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing Visual
COBOL on a machine that has no Visual Studio 2013 installed, the setup file installs Visual Studio 2013
Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

3.7GB 75MB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Note:

• Visual COBOL enables you to produce both 64-bit and 32-bit applications on 64-bit operating
systems.

• The Enterprise Server feature is not supported on Windows XP.

Software requirements

Note: This product includes OpenSSL version 1.0.1p.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Eclipse requirements

• The setup file installs Visual COBOL and Eclipse 4.4.2.

See Installing Visual COBOL into other instances of Eclipse for instructions on how to install Visual
COBOL into other instances of Eclipse installed on your machine.

Note: If you are installing Visual COBOL into Eclipse 4.5, you must install the Eclipse Target
Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):

1. Click Help > Install New Software in your Eclipse 4.5 and add a new repository for the location
http://download.eclipse.org/tm/updates/4.0.

2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.

• Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create
both 32-bit and 64-bit applications.

• Visual COBOL requires a 32-bit Java installation.

Software requirements

• Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from 
Oracle's web site and install it anywhere on your machine.

Note: If Java 7 is installed on your machine, to skip installing Java 8, run the Setup file with the
skipjre=1 command line option.

• The setup file also installs .NET Framework v4.5.2 and the Microsoft Visual C++ 2010 and 2012
Redistributables.

See the Java Support Considerations for the Eclipse IDE in the Known Issues and Restrictions section in
your product help for considerations that apply to using the Eclipse IDE and Java.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.
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System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(GB)

Sentinel RMS

license
server

(MB)

x86-64
running Red
Hat Linux

Micro Focus installer 923 3.69 1.84 46

x86-64
running SUSE
SLES

Micro Focus installer 927 3.71 1.85 46

Operating Systems Supported

Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Eclipse requirements

• Visual COBOL only supports the 32-bit Eclipse IDE and requires a 32-bit Java installation.
• Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create

both 32-bit and 64-bit applications.
• The setup file installs Visual COBOL and Eclipse 4.4.2. After the installation, you can install the Visual

COBOL plug-in into other instances of Eclipse available on the same machine. The supported versions
are 4.2, 4.3, 4.4, and 4.5 for the 32-bit Eclipse only. See Installing Visual COBOL into other instances of
Eclipse for instructions.

Note: If you are installing Visual COBOL into Eclipse 4.5, you must install the Eclipse Target
Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):

1. Click Help > Install New Software in your Eclipse 4.5 and add a new repository for the location
http://download.eclipse.org/tm/updates/4.0.

2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.

Other software requirements

Before installing this product, you must have the following software installed on your computer:

• The unzip utility is required by the setup file.
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• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

glibc-locale-32bit X X

gtk2 (libgtk2, gtk2-
tools-32-bit)

X

libXcomposite1-32
bit

X

libgdk_pixbuf-2_0-
0-32bit

X

gdk-pixbuf-query-
loaders-32bit

X

libjasper1-32bit X

gtk2-x11
(libgthread-2_0-0-
32bit)

X

libXtst6-32bit X

glibc-*.x86_64 X X

glibc-*.i686 X X

libgcc-*.x86_64 X X

libgcc-*.i686 X X

libstdc++-*.x86_64 X X

libstdc++-*.i686 X X

gtk2-*.x86_64 X X

gtk2-*.i686 X X

gtk2-
engines.*.i686

X

gtk2-
engines.*.s390

X

gtk2-
engines.*.x86_64

X X

libXtst-*.x86_64 X X

libXtst-*.i686 X X

libcanberra-gtk2-
*.x86_64

X X
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Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

libcanberra-gtk2-
*.i686

X X

libgnome.x86_64 X X

libgnome.i686 X X

PackageKit-gtk-
module-*.x86_64

X X

PackageKit-gtk-
module-*.i686

X

PackageKit-gtk-
module-*.s390

X

PackageKit-gtk3-
module-*.i686

X

PackageKit-gtk3-
module-*.s390

X

webkitgtk.x86_64 X

webkitgtk.i686 X

webkitgtk3.x86_64 X

webkitgtk3.i686 X

xterm (any
version)

X X

gdb* X X X X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The setup file installs Java
8 u51 32-bit. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

Note: On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse.
When you start the installation, if the 64-bit version of Java is already installed on your Linux
machine, you might not be able to install Visual COBOL. This is a known issue with the Oracle
Java installers for Linux which prevent you from installing both the 32-bit and the 64-bit versions of
Java on the same machine. To work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For

example, untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to

install and run Visual COBOL.

Before you start the installation, you need to set the environment as follows:
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• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Micro Focus Visual COBOL Development
Hub

Hardware Requirements

The disk space requirements are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

POWER
running AIX

Micro Focus

installer

419 1.68 GB 838 36.5

HP IA Micro Focus

installer

763 3.05 GB 1526 69

System Z
running Red
Hat Linux

Micro Focus

installer

346 1.38 GB 692 36

x86-64
running Red
Hat Linux

Micro Focus

installer

359 1.44 GB 718 46

SPARC
running
Solaris

Micro Focus

installer

405 1.62 GB 810 40

x86-64
running
Solaris

Micro Focus

installer

375 1.60 GB 750 31
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

System Z
running SUSE
SLES

Micro Focus

installer

349 1.40 GB 698 36

x86-64
running SUSE
SLES

Micro Focus

installer

364 1.46 GB 728 46

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note: This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library Platform

SUSE 11 Red Hat 6.x Red Hat 7

glibc-locale-32bit X

glibc-*.x86_64 X X

glibc-*.i686 X X

libgcc-*.x86_64 X X

libgcc-*.i686 X X

libstdc++-*.x86_64 X X

glibc-*.s390 X X

glibc-*.s390x X X

glibc-devel-*.x86_64 X X

glibc-devel-*.i686 X X

glibc-devel-*.s390 X X
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Library Platform

SUSE 11 Red Hat 6.x Red Hat 7

glibc-devel-*.s390x X X

libstdc++-*.i686 X X

gdb* X X X

• Visit the Red Hat Web site for more information.

• Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from 
Oracle's web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute COBOL JVM code, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse. When you start
the installation, if the 64-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevent
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
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• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and
run Visual COBOL.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Product Co-Existence
Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL for Visual Studio
To install this product:

1. Run the vcvsnnnn_232.exe file (where nnnn is the version of Visual Studio you're installing for) and
follow the wizard instructions to install the prerequisite software and the product.

Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a known Microsoft issue. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
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• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Visual COBOL for Eclipse (Windows)
Note:

• This version of the product is a full install.
• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an

Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:

1. Run the vce_232.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.4.2, with the Micro Focus plugins already installed,
in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have Java 7 installed on your machine and you want to skip installing Java 8, run the
setup file from the command line with the skipjre=1 command line option.

Installing Visual COBOL for Eclipse (UNIX)
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_2.3_update2_platform

2. Run the setup file with superuser permissions:

./setup_visualcobol_deveclipse_2.3_update2_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_2.3_update2_platform -installlocation="full 
path of new location"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

. /setup_visualcobol_deveclipse_2.3_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

Installing Micro Focus Visual COBOL Development
Hub

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_2.3_update2_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_2.3_update2_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_visualcobol_devhub_2.3_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
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While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.
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Licensing Information
Note:

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.

• This package provides eight licenses for using Micro Focus Development Hub on all platforms.
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• Personal Edition licensing is only available with Visual COBOL for Visual Studio 2015 and Visual

COBOL for Eclipse
• The latest version of the SafeNet licensing software is required. See the Software Requirements

section in this document for more details.
• Your entitlement for using this product is governed by the Micro Focus End User License

Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh
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Installing licenses

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product

Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click AuthorizeFinish to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
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UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

50 | Licensing Information

http://supportline.microfocus.com/activation


To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.
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